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DHiHNEFNTWET, Universal Cache &1 > A M—=ILT3I121E, LFOED
Universal Cache FICRENTNDA A R—)b « N Tr—I0WMETY, FEN
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3. solidDB V7.0 1 > A ~—JL - )Nwor—3

InfoSphere CDC
LFUr—vay
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aArvHR—%b solidDB | & D solidDB f1E®D solidDB
IBM solidDB 7.0 X X
IBM InfoSphere Change Data Capture solidDB 7.0 X
IBM InfoSphere Change Data Capture Access Server 6.5 X
IBM InfoSphere Change Data Capture Management Console 6.5 X
IBM InfoSphere Change Data Capture /N 27 L > R « 57—% « X
—/V— 6.5
LFonwdnm Ty,
e IBM InfoSphere Change Data Capture DB2 Linux, UNIX, and
Windows 6.5
e IBM InfoSphere Change Data Capture Informix 6.5
e IBM InfoSphere Change Data Capture Microsoft SQL Server 6.5
* IBM InfoSphere Change Data Capture Oracle Trigger 6.5
e IBM InfoSphere Change Data Capture Oracle Redo 6.5
* IBM InfoSphere Change Data Capture Sybase 6.5
* IBM InfoSphere Change Data Capture DB2 z/OS® 6.5
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DHMETT,
IBM solidDB 7.0 License Certificate X X X
IBM solidDB 7.0 Documentation X X X
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A=V b4

LSRRI - Ry =Y
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Windows

Linux $& U UNIX
solidDB-7.0-<platform>.bin

solidDB-7.0-<platform>.exe

T4 LMY —181E

solidDB 7.0 DT 7 # )L b DA > A b —)LTlE, so0lidDB7.0 EWHF 4 L7 M1 —

MERENET,
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MEENET,
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~
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bin solidDB NA FU—« 77 A )L B LG Z
ATV —-TrA)
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bin/N
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# 5. solidDB7.0 T« L2 N —Hi#& (#2F)
B B
jdbc solidDB JDBC R J - /)\—

WebSphere® THHT 20D T—% « A b
T e NIVS— T —=hAT
(SolidDataStoreHelper.jar)
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C:¥Windows¥system32 7« L7 hU—IlcaE—aNE7,
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lib¥

solidctrlstub.a

solidDB il API (SSC) A& T « 14T 51)—

ZOBNTATIT)—F, VU - FA4T 53— T A%l
AL TO—HIVZFETTESI—R, £RFVT - F514T5
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I BLGEITHEHALET,

solidac.a
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# 8. solidDB JDBC

0s: ODBC RIAN—+ X% =T v — -ty 7 v 7 (Windows DEHEEDH)
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1zx64: Linux for System z®. 64 Ew K
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LIFOgEIZ TR —hanThER A
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solidDB H—/\N— « N\ —J2i3, T—FEHREEHEMAOa =)L - V—)l,
BROT DIV AR—rEAR—MHOIAR Y MMra—T 1 UT 14 —MEXE
NTVWET,

nsoY—)Ea1—5 4154 —I& solidDB b—N—OA > Ab—)L - F 1L
7 MU —IiZH B bin T4 LV R)—IZHDET,
ary—=i-v=)v
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0, EWEHRZEODI—T—IF, O R-TJO 7 N2EHLT
ADMIN COMMAND Z%{7L720. ADMIN COMMAND Z&OA 7Y 7
ke D7 AINVEEFTEHIETEFDIAR RERITLEDTSHIENTESE
¥, solcon Z{HifH35&, ADMIN COMMAND 7% solcon BHIAO~N > R
TO—ELTHITITAHIENTEET,
solcon [T VL ATELDIIEMEHRZFFOI—F—DADID,
solcon OANEFIGAICT T 041 INTWBEE, EFHEL TV &%
HLAREMEDN DD SQL AT — AL M &S TEITLTIEWIT ER A,
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solidDB Speed Loader (solloado F72i3 solload)
solidDB Speed Loader (solloado F7z13 sollead) I&. M7 ¥ 1 IVins T
—IR—=ATFT—F%E=O0—RLZET,

solidDB T2 A7 Rh— b (solexp)
solidDB L7 Z7h— b (solexp) 1. T—FIXR—ANS Ty AT —F %
I ABR—KhLET, 7. solidDB Speed Loader (solloado E7zid
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InfoSphere CDC for solidDB

InfoSphere CDC for solidDB /X 7 —31C1&. solidDB &2 DD T —4 RX—Z &
OEDOT—FEFEZROANTEXRT S, LT r—ar TP 2D Tk
T T MNEENTNET,

7 9. InfoSphere CDC for solidDB DA > A ~—)L « £ X—2

a

VIR—=% 2t

AVAR=IV s N —

[F

InfoSphere Change Data Capture
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2 l3twic 43


http://publib.boulder.ibm.com/infocenter/prodguid/v1r0/clarity-reports/report/html/osForProduct?deliverableId=1270820449750
http://publib.boulder.ibm.com/infocenter/prodguid/v1r0/clarity-reports/report/html/softwareReqsForProduct?deliverableId=1270820449750&osPlatform=AIX
http://publib.boulder.ibm.com/infocenter/prodguid/v1r0/clarity-reports/report/html/softwareReqsForProduct?deliverableId=1270820449750&osPlatform=HP
http://publib.boulder.ibm.com/infocenter/prodguid/v1r0/clarity-reports/report/html/softwareReqsForProduct?deliverableId=1270820449750&osPlatform=Linux
http://publib.boulder.ibm.com/infocenter/prodguid/v1r0/clarity-reports/report/html/softwareReqsForProduct?deliverableId=1270820449750&osPlatform=Solaris
http://publib.boulder.ibm.com/infocenter/prodguid/v1r0/clarity-reports/report/html/softwareReqsForProduct?deliverableId=1270820449750&osPlatform=Windows
http://www.ibm.com/developerworks/data/library/techarticle/dm-0801doe/index.html

44

Microsoft SQL Server

* Microsoft SQL Server 2008
* Microsoft SQL Server 2005
* Microsoft SQL Server 2000

Sybase Adaptive Server Enterprise (ASE)
* Sybase ASE V15
* Sybase ASE V12.54
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L2 M) —fsEZRRT 70> 7 M nEd,
A A R=)VDO#&IH D IZ, InfoSphere CDC HEpKY — )l DB Z N L T,
InfoSphere CDC for solidDB - > A% > A Z&Hpk L £7,

2. WY —) V&M L T, InfoSphere CDC for solidDB DFH L WA LAY VA%
ERRL £9.

| 14.3.1, InfoSphere CDC DHF L WA > A > A ZBH1T 5I121E (Windows)J |

« |64 X—=2®D 1432, InfoSphere CDC DFTL WA A Y > A %87 51213
[(UNIX BE X Linux)J |

RDIAY

67 X=2D T44, Ny 7T K - T—4 « 3 —/)N—H D InfoSphere CDC D1 > A|

[F =)V ERERRD [THEAE T,

4.3.1 InfoSphere CDC D#HL WAL RH > REEBMTBICIE
(Windows)
FlE
1. A > AF—)U&IT InfoSphere CDC DEAIDA > AF > Az T 2551, 2
DFMEDAT v T 3 ITHEHET,
2. ARYR - 7OCTRT, UFOaAR Y REFEINZT 4 LI MU —THEfT
L. #pY — IV ZEEL £7,
¥<InfoSphere CDC Installation Directory>¥bin¥dmconfigurets
3. Uz L s AvE—IT, TOKI 227Uy 27 L THIITLET,

4. TIBM InfoSphere CDC New Instance] % 7117 + 7" 27 A® [Instance] &
T, LFOA T a 2Bl TExT,
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FTayv

GBI

Name

InfoSphere CDC A > A% > A D4 Hi & ATl
LET, ZOARNILIZ—7 THILEND
DET,

Server Port

InfoSphere CDC 7%, Management Console 33
FOZOMDY—N—ZETLTWD T F1
Tk U= AT —a > EOMEICMHA
THR—FEFEANLET,

F: ZOR—FESE BHCY—N—ITA >
A= ENTWBHOT TV r—2a3>T
RIS L3 TEERA. ZOR— MRS
{¥. Management Console DY 7t A - Y%
— V¥ = N=ARI T TTT—=4F + Ak
TDTIEA + NTA—F—&HETHEE
I L E T, InfoSphere CDC 3. T 7+
)V TCPIP 7R— b&EFD 11101 ZFKRL
9, 7L <Id. Management Console D&
BlaesL T<7/Z3n,

A FC /) — RICEROA DAY D A%A >
A S=ITBEE. &1 2 AY > ADHR—k
HEBEXLIZ - THHIUENHDET,

Auto-Discovery Port

ZDRwy 7 A %R LT, Access Server O
SEEESNSEF—bT 4 AANY— - TO—
RE¥E¥ A NTHEHATS UDP R— FEFZEA
HUET, A—bT 4 ZAHNY—=IZDWTH
L <13, Management Console D&EFl %S
LTS,

Maximum Memory Allowed

InfoSphere CDC IZEID#R5 RAM D K&
BEANUET, WK 2E1 A5 2D
< EH 64 MB ZEIDIRDVLEND D F

T, TIFIVETIE 32 Ev FDA Y
> AIZIE 512 MB @ RAM DYEID IR 5 1.,

64 Ev hDA AL 2 AIZIE 1024 MB D
RAM MEIDIRSNET,

Staging Store Disk Quota (GB)

InfoSphere CDC AT — > 7 « A N7 MY
— A VATATHATET 4 AT « AR—
ADBRKRBEANLET, T7 )V ME
100 GB T. &/MElZ 1 GB TY,

L7 r—ra oy —ry hELUTHEAT
54225 ARERT DA, 1| GB %1iF
FLET, ZHITED InfoSphere CDC M4
=79 N ATFLATHREETDT 4 AT -
)Y —Z&HIE L ET,
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Bit-Version DTFoWsnhoA 7 a > 28IRLT, 7
—HR=ZADEy b+ N—=T a3 VEBRLE
ED

e 32 Evhk

64 Ev bk

InfoSphere CDC % 32 Ew bk - H—/)N—I(C

A A= LTWBEHE, INs0F 7>
a A TEERE A,

5. [Windows Service] fHIH T. InfoSphere CDC B —tE XA DMHIGIZHEHT 2T Y
ChEBETEET, LFOF T aondnnz@#RL £9,

FTrav G|

Local System account 0=y« AT LEBEDT D2 R T
InfoSphere CDC H—E A &L £9°,

This account HELZI—Y— - 7> M T InfoSphere

CDC Y —EAZBHIBLET,

7 > M. <domain>¥<user name> D7
=Xy N THRETLHILENHD LT,
<domain> VFERED R AA 24T, <user
name> 3IRE LI RAAL COFRN RO T A
e A=Y —HTY, AEa—F =0 KA
A > DO—FTIRWEEIL., <computer
name>¥<user name> Z{EETEET,

MPassword| 1 27 ZB XN [Confirm
Password| 7~ 7 Z1Z, R L 7= Windows
A—H— « THD > MIBREREMT 5N T
WBHNRAT—RZANLET. InfoSphere
CDC DA > A b—)L#IZ Windows L—H
— T hHI L NDISAT— REEFLEZEE
2. Windows Services] -1 7 1O/ Z{#iH
L T. % InfoSphere CDC B —t AIZHUERH
EINTNENAT— REEHTHLEND
DEJ,

6. [Database) fHT. L7 U —2a  HOREZFOT —FIRX—ANDT VA
R TEET, COFEEZTTTDI2E. AT LEMEHRENLETT,
1. Management Console D7 7t X « Ix—T v — « N—AXRT T4 TTT
=%« AT ZBML, 21— —IZZDT—FN—ZADT 7 L AR Z LT
ZX5X91T/20 £, 7L <IX. Management Console DERIZHMML TS

2%
FIFav B
User name RELET—IR—ADI—F—%Z AL

EIR
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Password BELET—IR—ZADNNAT—REAHL
EC
Metadata Schema InfoSphere CDC A% T —% RIZHEHT 5T

— I R—=ADAF—IZERRLET,

T4 NELT, ERTANLZIZ—T—

HIMEASNET, A A=V INTNVS

B InfoSphere CDC - > A% > AMZEDT

— I R=ATHHAL TNDE AF—TZHRWN

T, FEOAF—XERETEET, ZDA

F—~IE. 1A =L ORHEEtEO &

LT, By N7y TEZEBRETELEND

DET,

O AYT—F - AF - BTRLT

ZEHLTCLIZS N, T72)L T

solidDB DT RTHDAF—4% (hyay

%) 1E. KXFTY,

Advanced [Advanced] "% > 2L T. solidDB

JDBC RIAN—DHERE/INT A —4 — %25

T&EZE9J. IDBC RTIAN—D/NTA—F—

IZOWTEEL<LIE. TIBM solidDB 707 5

Y= AR ) EBRRLTLZES N,

B b

« HA By F7 v 7 Tld, NTA—%—
solid_tf_level I3, 774V KT
CONNECTION IZEREINTNET,

« SMA ty h7 w7 T, NTA—F—
solid_shared_memory 1. =7 4 )l T
yes ICRRESNITWVET,

« FRL—F 4 2T AT L - R 2D
MR EAERNCT 286, LFOo 7O/
4 —ZERELET,

— solid_use_strong_encryption=yes

— solid_gskit_path=location_of GSKit_library
BE: ARXL—T 1427 - AT L - RN—
ADBIHANZ AL EHHL TL—Y—%
WAL S B85, IBM Global Security Kit
(GSKit) ZH—/N—&E2 5147 > SOy
DALEL—F—THMIT 2LEDNHD
ESCIN

7. [TServer] fEIKT. F—~¥ OEREEIIE R CEL. LU r—2a VHOT
NTOERZEZD solidDB H—/N—ZRTE LT, H—-P—/N\N—F/id HA #
Ji% (HotStandby) ZHERR TE £ T,

FTav B
Single server 8 L7z solidDB H—/N—DHK A hHER—
rEFEZANLET,
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FIFav B

Enable SMA solidDB THAHAEY — - 77X (SMA)
EHEATHHEEICE, ZOFv Y Ry
A&BIRL £,

HA Configuration (HotStandby) fRELZ 1 KBELD 2 K solidDB H—/\—

DRAHER—bFESEANLET,

8.

TOK] #7271 w727 LT, InfoSphere CDC A > A% > XA DML E Z IR17F L £
ER

HHR— R INTNWARNWI > I— KA InfoSphere CDC Ik > THRtEEN D &, &
BL>a—R2UZAMNSERT L0051 7 OTNERINET,

UFoWFNnoRyY > 220y LT, REZ>O—-ROUANET VY —
HNF S ZEBHTEEXT,

o Closest match — T— Y IZEHENW—BEH THHIRBEL I— RNE RS
NEI,

+ Comparable encodings byte length — /N NEDJEFTREL > a— RNE
IRENET,

e All - IRTOMREBL O— RNEXRINZET,
JZ MBI >O—R2ERLT, [OK) 227U v 7 LET,

[Cancel] 27U w7 §5EL, TI—+  Avt—UNERIN, 1 2AF A
TERR S NER A,

RDH XY
Wik 252 7 U721, InfoSphere CDC ZBHBETE X9,

4.3.2 InfoSphere CDC DFH LW\ RH L RZEMT BICIX
(UNIX & Linux)
FIE

1.

A > A b—)V#RIT InfoSphere CDC DHmMIDA > A K > A%tk d 585513,
COFEDAT Y T 3 ITHEARET,

AR 7O 7 KT U FOax >y REfEESNzZT4 L7 M) —T%EST
L. WYy —IVEESHL £7,

/<InfoSphere CDC Installation Directory>/bin/dmconfigurets

3. UxIVHL c AwtE—T, Enter F—2 L THITLET,

InfoSphere CDC DFiLWWA > A > AZBIMT 572D, 2 AL T Enter
F—ZEWL X9,

. InfoSphere CDC f > A% > AD4fi%E AL, Enter F—ZHLET, 12X

G OABEA = THAHIBENRHDET,

InfoSphere CDC 73, Management Console X NZDMDH—/N—ZFLTL T
WBIIA T = AT —a EOBEBIHEHT LR NEEE AN
L %79, InfoSphere CDC X, T 74 )V - R—hFFEFD 11101 Z2ZFRL X
9. Enter +—Z#L %7,
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H: ZOR—FEFIF. ACH—N—=IZA A M=)LINTWBHOT 7V
—2a THATASZEETEER L. ZOR— &SI, Management
Console DT 7YX A + 2=V ¥ — + WN—=ART T4 TTT—H + ATDT Y
TANITA—F—ZRETHEZIHHLET. 7L <IE. Management
Console DERIZZHL T 7Z3 W,

H: WU/ —RICEBDA A A% ANV TH55. &1 A5 >
ADR— I EBZIIZ—V THEIULENDDET,

LT IRA SRRy =TT A AANY —HEEEFEHL T2 5E,
Access Server TaiE L7z UDP h— hEFZANI LT, ZOHEEZE fH nTREIC
HE L TL 23, InfoSphere CDC 1&. Access Server NHEFEINDHA— b
TAAANY— - TO—RFL A NAHIC, 2O UDP R—hEHZEMHEHL £
9. TNLNDOEEIL. Enter 2L T OREEEZMHARICLET,

. InfoSphere CDC IZHID kWA AIRE/R RAM O&EZ AN LET, #E
RS DEA DAY L AIDELED 64 MB ZEIDIRDVLENHDET, 77
IV RTIE, 32 Ev FDOA > AF > AL 512 MB @ RAM DEID RS 1,
64 Ev hDOA A% > AIZIE 1024 MB @ RAM DEDIERS N T,

9. Kk 9 % solidDB H—/N\N—DHERSY 1 TEBIRL X7,

FFar

GIL

Single server

1 ZAL. Enter F—2Z{L £7,

HA Configuration (HotStandby)

2 ZASIL. Enter F—%2HL £,

10. EHT 28T 1 71> TRA MR ER—FESEZANLET,

FFar

GrLl

Single server

1. FBELEY—N—DRANGEASL,
Enter F—%Z#HL £7,

2. HELEY—N—0DOR—rESEAS
L. Enter F—%2fLE9, 773 b
1% 1964 T,

HA Configuration (HotStandby)

1. BELZ 1 RY—N—0DKAMLZEAN
L. Enter F+—%#HL £,

2. HHELZ 1 RY—N—OR—+HF52A
1L, Enter ¥—2#MLF£d., 73
M 1964 TT,

3. fRELE 2 RY—N—0DKA  4ZE AN
L. Enter F+—Z#L £7,

4. HELEZ 2 KY—N—0Dh— hEFZA

1L, Enter F+—2MLFd., T 724)b
N 1964 T,
AL RS 2 RANERID /) — RICELE
SNDEMESNTNDZD, 1 KAl&
2 REUDOFT 74V hOR— NEFEFIZFC
TY., AL FMOENT. 1 KY—
N—& 2 RY—N—%FELC /— RICE®E
THEHEINE. MADOT 74V EDR—
FESZFRICICTDZEITTEER A,
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11. %HEIZHEUC T, solidDB THAAETY — - 771X (SMA) Z2FHTESLS1C
BINLET,

FTav i

Use default settings n ZAJ1L. Enter ¥—Z#L X7,

Enable SMA y ZANL. Enter ¥—Z#L £7,

12. MEIZIRU T, #l/8T A—4— (JDBC /NT A—%—) ZRERL£7,

FTrav BiL]
Use default settings n ZAJJL. Enter F—Z#ML £7,
Modify settings 1.y ZAJL. Enter F—%MLET,
2. <parameter>=<value>;<parameter>=<value>;... f
ZEALT, NIA—F—FEEATTLET,
(=74 1

*« HA £y b7 v 7Tl /NT A—%— solid_tf_level
I&. T 7 4L N T CONNECTION ICRRESNTVET,

* SMA £y F7 v T TR NTA—F—
solid_shared_memory |¥. 77 4 )L KT yes IZFES
NTNET,

e FARL—=FT 4 2T ZAT L N—ZAONERREEE R
K556, UFOT0NF—2#ELET,

— solid_use_strong_encryption=yes

— solid_gskit_path=location_of_GSKit_library

BE: ARL—T 42T - VAT L R=ADHFEA N
ZALEMAL T — 2RI 555G, IBM Global
Security Kit (GSKit) Z2H—/N\—& 27 517 > NOW}
DAL E2—F—THENNT2HENHD ET,

13.
14.

15.

16.

17.

HELET—R—Z2Q01—Y—%H%Z AL, Enter F—Z2HL £7,
HBELET—IRX—ZAD/NAT—RZEZAN L. Enter F—ZML 7., HY
— NI, T=HIR—ATAF—XERRLET,

HHT DAY T—4 « AF—XICHINT 2% 5% AL, Enter F+— %L £
E

T—=IN=ANDNIIVIFEAERT 274 L7 FU—DNXAZEANLET,
Enter F—Z#L £7, solidDB 7—% X—ZA & InfoSphere CDC Difi 512, Z
DT 4 L7 B =TT HF M0 HER & ZADHERD B E T,

T

* InfoSphere CDC D1 > A% > AT &I, BiscT 4 L7 M) —%HT D4
BENHD LT,

« ZOT4 LI RMY—IZE, LU= a  HOT I R—ARNETEND
ZENHVET, ZOT4 LT M) —~"DL—Y— « 77 AR ZRET
HEEF. TOZEEFBRLTLILEI N,

PHR—FINTVWARWI > O— R InfoSphere CDC XX > THRIETN S &,

II— - Avt—INERIN, B0 -RZBERTEHIDITRKOSNE

ER

a. y ZEANLT, RICEAET,
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18.

H:n ZANL., Enter 2L TFr > BILT B E, 12 AY 2 ANIERS
NER A,

b. ZANLT, REL>I—ROERFEZBERNLET,
c 1 - TR ACERDEVN-HIHATH 260K BEL > I0— RNER
INETJ,
« 2 - N1 MROEFTEMBREL - RPERINET,
« 3 - IRTOAYEREBEL A—-RBERINET.
c. HATAHTI—-ROEFSEASNLT, Enter 2L E7,

R —IVIZ XK > T InfoSphere CDC A > A% Z ADMERKR I N, 1 2 AF A
DRt ZERT 70> T ERHENET, y EANL T, 1 2 AY P AZRIAL
i@‘o

F: BRICE S TEEDA DAY D ADAYTFT—INEEEINLD LS
A, By —Iick-oTtr7o> 7 R HENET,

4.4 Ny VIV R - F—4% - H—/)\—H®D InfoSphere CDC DA VR b—

W EER

Ny LR «F—4% « 3 —)N—HOD InfoSphere CDC % > A b —ILT %ITid.
AAR=I s T4 = ROFIEIHENET, 1 > A M=), InfoSphere CDC 1%
p —)L & H LT, InfoSphere CDC f > A% > A %ML £7,

R BRI

NI LZYR e T—=4 « = N—DBHL TNELE2HERLET,

N LR F—=FR=ZAEERLTHEET,

NI IR F=FR=ZADI—HF—HENAT— REHRLET,

Ny LR F—% «H—)N—7" listen $2%y hT—2 - 7 RLZAEHR—h
FeeiR L X9,

InfoSphere CDC A Y T —& RZVER T HBRICHEH T 5 AF—< Z2HBU/ER L
THLID, BHFEOAF—VEBRLTHBEET,

F&

1.

A VA=)V ORitE RN 2R L T,

A AR —IIVEFIZONTIE, Ny VTR - F—% - —=N—HD
[ InfoSphere Change Data Capture DL > R « LT—H—[F&R O T4 2> K
—JVDETIZ) O'r g VITEARSH D XT.

N 2TV R+5F—% « ¥ —N—H InfoSphere CDC #1 A F—JVLET,

LI NI TR -FT—% « $—NN—H®D [InfoSphere Change Data
Capture DL > R « Z—H—[[iF&F D [InfoSphere CDC DA > X k—JL] @
v a EaEZRLTLEI N, A4 2AMILO#KDDIZ, InfoSphere CDC %
By — )V DL E) % 3R L T, InfoSphere CDC f > A% > A %ML £,

kY —IVEHL T, Ny 2TV R 5F—% « —N—fD InfoSphere CDC
DHFHLWA VAY VAZERLUET,
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LI NPT R - T—% « $—=)N—H®D [InfoSphere Change Data
Capture DL R « Z—H—[AT&F O [nfoSphere CDC DFEEL) Dt 7 T =
CEZRLTEST N,

RDERY

[ T4.5, InfoSphere CDC Access Server D1 > A h—)L ERHkJ |

4.5 InfoSphere CDC Access Server DA R b—)L &8

Access Server 21 A R—=)LTBITIE. A A=)V« T4 P — ROFEITHNE
To A ARV, Fy U= THRERICEHNR - NERBEETET7 7y T Y
F—IVERZZOMDOEF 2T 4 —  ANZZALZHEHL TWEHEIL. oa
2B a—%—M Access Server U—E XL DWBEICHEHATELR—MNEIEET 24
BWNHDET,

F&

1.

(InfoSphere Change Data Capture Access Server 354 (X Management Console |
[r>ZRL—2ar - AR OFBHIZHS T, Access Server &1 > A h—Jb
LET,

HE: Access Server 7 B > NI, 1 A M= IURRICIER I NET,  Access
Server 7™ > M., AFOEIED=DIMEHETNET,

* Management Console ([ZO7 1 > 9 5,

+ Management Console TL1—H—&tF—% « Z N7 Z2EHT 5,
REICLETHNUT, MOa > Ea—4—0 Access Server ' —E X & DIEFIC
HHTELR—rEEELET,

FIEIZDOWTIX,  InfoSphere Change Data Capture Access Server 35 KU
[Management Console D1 > A hL—2 a2 - A Rl @ TAccess Server D1 >
A=l Ovr v a 2ESRLUTILEE N,

RDERY

[ T4.6, InfoSphere CDC Management Console D1 > A h—)L EH§pkJ |

4.6 InfoSphere CDC Management Console DA >R b—JL & 18Rk

Management Console % > A b—I)Ld 2I121E, 1 A =)L - U4 P — FOFJHIC
PENET, 1> A=), Access Server D1 > A b —)UIRFICIERR L 72 2 AT L5
MHEY D > ~Z&FEH LT, Management Console {[ZO %711 > LET,

F&

68

1.

(InfoSphere Change Data Capture Access Server 354 (X Management Console |
[r>Z L =3 ARl OFBAICHES T, Management Console & > A
r—=ILLUET,

2. Access Server D1 > A M—J)VRFITHER LIz AT LEBE T IO > AL

T. Management Console 217271 > L %9,
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RDERY

« [Help] > T[Help Contents] A= x1— - /NAZfiH] L T. Management Console
ONTXEEFRUET,

e Universal Cache Otz 7w 72T LET,
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5 Management Console ZfEF L=+ v v adty b7 v 7

InfoSphere CDC Management Console [IXF6 GUI »V—I)LC. Frvia--T7—%
R=ZAENY IR« T=HIXR=ZAMOL TV r—a > (Frvia) 77X
72ar ERBLOEZY—T5DIHHTEEY., 2Oy a T
FHMEHOL 70— ay s BT AT T a o EERT B HEOEARN I %
ML ET,

B BHIIC
o BEITAEMNY I IR « T—IR—AHEETHIEEZMHRLET,
* solidDB BLXUNY T IR« T=IXR—ANBEEH L TVWDZ EE2MHRLET.

¢ solidDB BELUNY I TV R+ F—% « —/N—H D InfoSphere CDC - > A%
CANBEHL TNWAZ LR LET,

o T=HIR=ZAITWNTDTNRT IV AMEZFE> TWS I EE2HRELET,

e EVXA N —ILZHE-S T, EEL WL U r— g FHAIZERLIZZ L 20
HLET,

FE

1. Access Server {Z#6iL T Management Console ICO027 1 U E T,

LU <&, [lInfoSphere Change Data Capture Management Console EFEITA |
D [Management Console D7 > (Access Server NDIE#HE) Ot a >
EZHRLUTZE N,

E > b: Management Console D7 7t « X %x—T v — « N—=AXRT T4 T T
E¥T 21203, 77— - AT &Y — - 7 hHU > NOEHFEEZFF O AT
LERETRINERD ER . AT LEMEDTY /1 > Mid, Management
Console D > A b —)VRFIZIERRBE AT,

2. solidDB BXUNY I IV K+ F—=FRX—ZAHDF—% - A+T7EEY TV T
LXEJ.
a. solidDB T—ARX—ZHDH L WF—% « AT ZBMLET,
1) [Access Manager] > [Datastore Management] %7 U w7 L£79,
2) [File] > TAccess Server] > [New Datastore] =71 w7 L£7,
3) 7% « AT O4HIZ [Name) Hy 27 AIZANLET,
4) % [Description] v 7 ZICANTLET,

5) [Host Name| 7~ % Z1Z. InfoSphere CDC for solidDB % > A k—)l
L7 —=N—0DORA MAEZITMES IP 7V FLAZ AN LET,

6) [Port) "7 AT, InfoSphere CDC MDD I > HR—F% >~ EDHEFIC
AT 5HR— hE&EFZATILET, #iIZIE. InfoSphere CDC for solidDB
PERAT 2T 7 )V FOR— FEFIE 11101 T,

7) B—/)N—% ping LET, L7z E. InfoSphere CDC %1 > A b—
WL —N—DF A TBIOEFDON—2 3 D FBEZFD, T4« A
EY - 7ONRT 4 —DRENEKT.

71
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b. NI IR« FT—=IX—ZHOH LWT—% - AT ZBMLUET,

1) T[Access Manager] > [Datastore Management| %727 U w7 L £,

2) [File] > TAccess Server] > [New Datastore] =71 v 7 L£7,

3) 7—4 + AT D4H[%E [Name) w7 AT ANTLET,

4) #H% Description] 7w 7 ZIZANTLET,

5) [Host Name] 7R %~ ZIZ. InfoSphere CDC % > A h—)L L7zt —/\
—DRAMGBIOHS IP 7 RLAZANLET,

6) [Port] 7R~ ZIZ. InfoSphere CDC AMELD I > R—F > h EDEIEIC
FHTER— ESE AN LUET, AL, InfoSphere CDC for Informix
PMERT ST 740 FOR— F&EFIE 10901 T,

7) Y—/N—% ping LET., kL 7=8H. InfoSphere CDC % > A h—
WL —N—DF A TBIO-HFDON—2 a3 > HFFEEFD, 7—4 + X
K7 - TONRT 4 —NREINET,

c. I—H—%F—% - ANTIZEIOHXTET,

FU1—Y—%, solidDB T—% + ARTENYIIIR+FT—=45+ AT D

M AICEI DS THHEND D ET,

1) TAccess Manager] > [Datastore Management] Z 7 w7 L £79d,

2) T4 - AT ERIRLET,

3) H27UwZ L. [Assign User] Z#RL £,

4 1 NOI—Y—2ERT DN, Ctrl F—2WL-FFERKOI—T—%
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